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You can change the order of the preferred networks by selecting the Wireless LAN Network that
you want to reposition on the list, and then clicking Move up or Move down. You can change the
Wireless LAN Network connection settings of a preferred network by selecting the Wireless LAN
Network, clicking Properties, and then changing the settings as needed. To remove a Wireless
LAN Network from the list of preferred networks, select the Wireless LAN Network that you want to
remove, and then click Remove.
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If a network is not defined in the preferred networks list, but you know it is available and you want
to automatically connect to it, then click Advanced in the Wireless LAN Networks tab, and select
the “Automatically connect to non-preferred networks” check box.
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6. Windows NT 4.0

6.1 Driver installation and TCP/IP Setup
Windows NT 4.0 does not support Plug-and-plug. Therefore, the 802.11a NDIS driver installation
uses an approach that is different from the installation used in other Operating Systems. In order
to install 802.11a  Wireless LAN Network Adapter in Windows NT 4.0, a PC Card utility called
CardWizard is used. If your computer system does not have CardWizard utility pre-loaded then
you can purchase it from SystemSoft Corporation (www.svstemsoft.com) or you can download a
14-day evaluation copy from ftp://www.systemsoft.com/pub/Wn51tren.exe. Note that CardWizard
requires Windows NT 4.0 Build 1381 (Service Pack 6) installed in order to function correctly.
Please install Service Pack 6 if your Windows NT 4.0 is not updated

After CardWizard utility is loaded, insert the 802.11a  Wireless LAN Network Adapter into a 32-bit
CardBus slot, and follow these steps to install the NDIS driver: 1.
1. CardWizard will detect the insertion of the 802.11a CardBus card and show the following

screen. Click Correct to Continue.
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2. Click OK to continue.

3. Windows NT 4.0 Network Properties windows displays. Click Add to continue.
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4. Click Have Disk.

5. Manually enter the location of where the 802.11a NDIS 4.0 driver is located. For example,
D:\NDIS\BIN\NDIS4. Click OK to continue.
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6. Make sure 802.11a  Wireless LAN Network Adapter is selected. Click OK to continue.

7. Set Map Registers value to 256 (default value) and click Continue.
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8. Windows NT 4.0 binds TCP/IP protocol to 802.11a  Wireless LAN Network Adapters and
TCP/IP properties have to be entered. Depending on the type of network the station
connects to, Gateway and DNS Configuration information may also be required. IP
configuration information (DHCP or assigned IP address, Gateway and DNS server IP
addresses) is usually obtained from the corporate IT staff. For a simple demonstration, the
station is assigned a static 1P address. Choose "Specify an IP address" and enter an IP
address and subnet mask. Assigning an IP address and subnet mask allows the station to
interact with the AP or other stations in the same IP subnet. Click OK to complete the TCP/IP
configuration.
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9. Restart the system for the changes to take effect.

6.2 Device Configuration
Configuration of the 802.11a  Wireless LAN Network Adapter can be done through the 802.11a
NIC Configuration Control Panel applet . Similar to Windows 2000, the device can be set to work
in one of two modes, either infrastructure mode or ad hoc mode. See Section 2.4 for more details
on these network connection types.

Start 802.11a NIC Configuration utility form the Control Panel.
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Select one of the configuration(s) under the configuration list and click Modify or click New and
follow the Section 6.2.1 and Section 6.2.2 to set up the station to work in infrastructure mode and
ad hoc mode.

6.2.1 Infrastructure Mode

This section defines the process of configuring an 802.11a  Wireless LAN Network Adapter in
infrastructure mode. Refer to Section 2.4 for detailed descriptions of each option in the Network
Configuration Settings.

1. Under the "General" tab, make sure the "Locally Administered Address" checkbox is
unchecked. Use the following information as a guideline to choose the values of each field in
the configuration window:
� Configuration Name: This field identifies the configuration. This name must be unique.

Configuration names are case insensitive. For example, "AP".
� Network Name (SSID): This is the name of the IEEE 802.1 la Wireless LAN Network.

For example, "802.11apP". This field has a maximum limit of32 characters. If
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this field is left blank, the STA will connect to the AP with the best signal strength.
� Network Connection: AP (Infrastructure)
� Power Saving: This field allows the configuration of power management options. The

options are Off, Normal and Maximum.
� Turbo Mode: This field enables or disables 802.11a Turbo mode.
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2. Usually, infrastructure mode is used in an enterprise environment where APs are installed
and maintained by corporate IT staff. Much of the data in the enterprise network is
confidential. It is important to configure security to make sure only stations with appropriate
keys can receive sensitive data. The 802.11a  Wireless LAN Network Adapter and NDIS
driver support key lengths of 40-bits, 104-bits and 128-bits. Typically, the appropriate
encryption and decryption keys will be supplied by the corporate IT staff.
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6.2.2 Ad Hoc Mode
This section defines the process of configuring an 802.11a  Wireless LAN Network Adapter in ad
hoc or IBSS mode. Refer to Section 2.4.2 for detail descriptions of ad hoc operation.

1. Similar to the set up of AP Infrastructure mode described in the previous section, ad hoc
mode is also configured by changing the options in "Network Configuration Settings" window.
Use the following information as a guideline to choose the values of each field in the
configuration window:

� Configuration Name: This field identifies the configuration. This name must be unique.
Configuration names are case insensitive. For example, "Ad Hoc".

� Network Name (SSID): A Network Name is mandatory for ad hoc mode. The SSID for
all stations in a single ad hoc network must be the same.

� Network Connection: Ad Hoc.
� Power Saving: Power saving mode is not currently supported in an ad hoc network.
� Turbo Mode: All stations participating in the ad hoc network must have the same rate

setting.
� Locally Administered Address: This field defines the locally administered MAC address

(LAA). To enter a value in the address field, the check box needs to be selected.
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2. You may optionally set up security features but it is not typically a requirement since the
duration of the ad hoc network tends to be limited. Currently, only shared key security is
supported in ad hoc mode. Future 802.11a software implementations will provide unique key
support.

3. In ad hoc mode, a station will scan the air for an existing Basic Service Set (BSS). If no BSS
is found, the station will establish a BSS for other stations to join. When other stations scan
the air and find an established BSS in place, they join that BSS to form an ad hoc network. If
a specific set of stations requires ad hoc network connectivity, it is recommended to have
one station establish a BSS first before configuring the remaining stations. This will prevent
the scenario of several stations trying to form a BSS at the same time, which may result in
multiple singular BSSs being established rather than a single BSS with multiple stations.
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6.2.3 Verify Connection
You may use LinkMon utility to monitor the operating status of 802.11a  Wireless LAN Network
Adapter once the STA is connected. Please refer to Chapter 7 for descriptions of LinkMon utility. If
the STA is configured properly then you will be able to perform ping test as well as other network
applications that a wired Ethernet device can perform.

1. Click Start, Programs, Accessories, and Command Prompt to open the Command prompt
window. Type "ipconfig" to determine if the TCP/IP configuration has taken effect. To test IP
connectivity in ad hoc or infrastructure mode, use the "ping <ipaddress>" command.

2. To map the drive on another machine to your computer, right-click “My Computer” and click
“Map Network Drive….”
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3. Specify the path of a network-shared folder.

4. After mapping the drive, you can perform file transfers, video streaming, and all other
network data transfers that are normally performed with wired 10/100 Ethernet connections.
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6.2 driver Un-installation
This section provides uninstallation procedures for removing the 802.11a NDIS driver from the
system.
1. To remove the NDIS driver from the system, go to Control Panel and open Network

properties.
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2. Under the Adapters tab, choose 802.11a  Wireless LAN Network Adapter and click
Remove.

3. Click OK to confirm the removal of the 802.11a Wireless LAN Network Adapter.
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4. 802.11a  Wireless LAN Network Adapter is no longer listed under the Adapters tab. Click
Close to continue.

5. Restart the system to complete the un-installation of 802.11a NDIS 4.0 driver.
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7. LinMon

7.1 Installation
LinkMon is a Graphical User Interface (GUI) program that provides detailed operational status and
statistics for the 802.11a  Wireless LAN Network Adapter. The LinkMon executable file,
linkmon.exe, is included on the 802.11a Release Version 1.2 CD, and is in the folder:
\ndis\bin\production\. Copy this file from the CD to a local driver for execution.

Since Windows 98 SE does not have native support for WMI, which is required to make LinkMon
work correctly, an upgrade from Microsoft is needed. Use the procedures described in the
following section to acquire and install the necessary WMI module from Microsoft. This is only
required for Windows 98 SE installations.
1. Download WMI installer from Microsoft (wmi9x.exe) and save it to your hard disk.
2. Execute WMI installer by double-clicking wmi9x.exe.
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3. Click Next to continue.

4. Click “I accept this agreement” and then click Next to continue.
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5. Click Next to continue.

6. The installer now installs files to the SYSTEM directory.

7. The system must be rebooted for the WMI installation files to become effective. When the
system completes the rebooting process, launch LinkMon.
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7.2 Features
There are five tabs in LinkMon used to display STA information:

� General Tab
� Frame Statistics Tab
� Transmit Retries Tab
� Station Tab
� Driver Tab

Under the General tab of the LinkMon program property sheet is general information about the
program and its operations.

Under the Frame Statistics tab is statistical information showing the number of frames being sent
and received, retry count on frames sent, frame checksum error counts for received frames, and
receive signal strength indicator (RSSI) information. These fields are described in the Station
Programmer's Guide under Appendix A as OIDs. LinkMon supports most of the OIDs listed in that
section.
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Under the Transmit Retries tab is detailed transmit retry statistical information for transmitted
frames.
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Under the Station tab is detailed BSS information including SSID, BSSID, association status,
operating channel frequency, and information about scanned APs.
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Under the Driver tab is statistical data pertaining to NDIS driver operation.
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The Action menu enables a NDIS driver unloading and reloading, and network interface card (NIC)
reset. Note that driver unload option is not available in Windows Me, Windows 98SE, and
Windows NT 4.0. NIC reset is also not available in Windows NT 4.0.
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On the Options menu, click Settings….

Under the Display tab, you can select the data display modes of “Cumulative” or “Relative.”
“Cumulative” mode displays statistical LinkMon data collected from the beginning of driver load.
“Relative” mode, displays differences in the statistical data since the last update.
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Under the Log File tab, the logging function can be enabled to log to a file the statistical
information collected by the LinkMon utility, for later reference or post processing by an application
such as Microsoft Excel.
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8 Country Code Selector

Starting from Release 1.1, the 802.11a Wireless LAN Network Adapter has EEPROM locations
allocated to store country code information. Currently, there are three countries available to select
from -- United States, Canada, and Japan. These countries represent two regulatory domains,
namely the FCC (USA and Canada) and TELEC (Japan). When the country code is changed, the
NDIS driver scans only the legal frequency channels allowed in those countries.

The country code selection utility is provided as part of the NDIS driver package in Release 1.2 to
allow users to switch to different countries. This utility is located under \NDIS\BIN\ARCCSEL in the
CD. Start Country Code Selector by running ARCCSEL.EXE and follow the steps below to change
countries.

1. Make sure the 802.11a Wireless Netwok Adapter is listed under Network Card field. From
the Country pull-down menu, choose the country that you want to switch to.

2. Click Yes to continue.
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3. The country selection takes effect immediately. You can use LinkMon to verify the country
that you selected by looking at the Regulatory Domain field in the Station tab.
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9 Troubleshooting

This chapter provides solutions to common problems that usually occur during the installation and
operation of the 802.11a Wireless LAN Network Adapter. Read the following descriptions below if
you are having problems. If you cannot find an answer here, please contact an field application
engineer for assistance.

1. My computer does not recognize the 802.11a CardBus reference card.
Make sure the CardBus card is properly inserted into a 32-bit CardBus slot. If Windows does
not detect the hardware upon insertion of the card, the system could have a previous
802.11a NDIS driver installed. Remove the old driver and try again.

2. The 802.11a  Wireless LAN Network Adapter does not work properly after the driver is
installed.
Re-insert the CardBus card into the slot. A beep should be heard if the adapter is properly
inserted. Go to Device Manager and make sure the 802.11a Wireless LAN Network Adapter
exists under the network adapters device node. If you see the yellow exclamation mark then
there are conflicting resources. In this case, make sure the computer system has a free IRQ
and make sure you have installed the proper driver. Uninstall the driver, restart the system,
and repeat the driver installation steps if necessary.

3. Stations cannot associate in ad hoc mode.
Make sure the Same Service set identifier is specified for all stations that need to join the
same ad hoc network. Set up one station to establish a BSS and wait briefly before setting
up other stations. This prevents several stations from trying to establish a BSS at the same
time, which can result in multiple singular BSSs being established, rather than a single BSS
with multiple stations associated to it.

4. The station cannot access the Internet in the infrastructure configuration.
Make sure the station is associated and joined with the AP. If Wired Equivalent Privacy
(WEP) security is enabled on the AP, the station must have the proper WEP keys specified.
Also make sure TCP/IP properties are correctly configured.

5. ARCCSEL Country Code Selector shows the following error message: No
configurable 802.11a network cards were found in this system.
Make sure the 802.11a Wireless LAN Network Adapter has Release 1.1 EEPROM contents
programmed. 802.11a CardBus Reference Design boards that were released prior to
Release 1.1 do not contain the regulatory domain information in the EEPROM. Therefore,
the country code selection utility will not recognize the card.
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Appendix A – Channel and Data Rate Selection

This section provides basic information for selecting fixed data rate and channel frequency in the
NDIS driver. This becomes necessary if you want to test the 802.11a Wireless LAN Network
Adapter at a specific channel with the rate adaptation controls turned off.

To select channel frequency and data rate in the Windows environment with NDIS driver installed:
1. Click Start, Run, and type "regedit” to open Registry Editor
2. For Windows 2000 and Windows XP, locate the following registry key, and select Find from

the Edit menu:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\

For Windows 98SE and Windows Me, locate the following registry key, and select Find from
the Edit menu:
HKEY_LOCAL_MACHINE\System\CurrnetControlSet\

3. Type "clist" and click Find Next to find the registry key. Note that if you have multiple
instances of the 802.11a Wireless LAN Network Adapter installed, for example, the NDIS
driver is installed more than once, then you will need to click Find Next to locate the current
instance of the device that is in use.

4. Double-click on clist and enter the channel number in the "Value Data" field. Enter the IEEE
channel number from the following table. For example, enter 40 to select channel frequency
of 5.20 GHz. The channel numbers follow the IEEE format where:

Channel Frequency (in GHz)= 5 + 0.005 *(Channel Number).

Channel Number Channel Frequency Regulator Domain
26 5.13 GHz N/A (not calibrated)
28 5.14 GHz N/A (not calibrated)
30 5.15 GHz N/A (not calibrated)
32 5.16 GHz N/A (not calibrated
34 5.17 GHz TELEC
36 5.18 GHz FCC
38 5.19 GHz TELEC
40 5.20 GHz FCC
42 5.21 GHz TELEC
44 5.22 GHz FCC
46 5.23 GHz TELEC
48 5.24 GHz FCC
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Channel Number Channel Frequency Regulator Domain
50 5.25 GHz N/A (not calibrated)
52 5.26 GHz FCC
54 5.27 GHz N/A (not calibrated)
56 5.28 GHz FCC
58 5.29 GHz N/A (not calibrated)
60 5.30 GHz FCC
62 5.31 GHz N/A (not calibrated)
64 5.32 GHz FCC
66 5.33 GHz N/A (not calibrated)
68 5.34 GHz N/A (not calibrated)
70 5.35 GHz N/A (not calibrated)
72 5.36 GHz N/A (not calibrated)
74 5.37 GHz N/A (not calibrated)
76 5.38 GHz N/A (not calibrated)
78 5.39 GHz N/A (not calibrated)
80 5.40 GHz N/A (not calibrated)
82 5.41 GHz N/A (not calibrated)
84 5.42 GHZ N/A (not calibrated)
86 5.43 GHZ N/A (not calibrated)

5. To select the fixed data rate at which you want the station to transmit, double-click on
rateCtrlEnable from the same registry key location where clist resides, and enter 0 to disable
rate adaptation. Double-click on TransmitRate and enter the value specified in the following
table to select the actual data rate. For example, enter 3 for 18 Mbps.

Rate Number Data Rate
0 6 Mbps
1 9 Mbps
2 12 Mbps
3 18 Mbps
4 24 Mbps
5 36 Mbps
6 48 Mbps
7 54 Mbps
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6. For the changes to take effect:
� If you are running Windows 98SE or Windows Me, close Register Editor and restart

the systems.
� If you are running Windows 2000 or Windows XP, unload and load the driver from

LinkMon.
7. To undo these changes and go back to normal operation where the channel and data rate

are dynamically set, change rateCtrlEnable to 1 and clear the clist value.
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one of the following
measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
- Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: To assure continued compliance, (example - use only shielded interface cables
when connecting to computer or peripheral devices) any changes or modifications not expressly
approved by the party responsible for compliance could void the user's authority to operate this
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. This equipment should be installed and operated with minimum distance 2.5cm
between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or
transmitter.




